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Resumo: A dinâmica das estruturas é um campo da engenharia que estuda o 

comportamento das estruturas submetidas aos efeitos dinâmicos. As cadeiras que 

compreende esse campo têm sido cada vez mais inclusas nos cursos de engenharia civil. 

Assim, durante o desenvolvimento da cadeira de Dinâmica das Estruturas na 

Universidade Federal do Pará - Campus Universitário de Tucuruí, foi perceptível a 

dificuldade dos discentes com o entendimento físico dos fenômenos que compreendem as 

análises modais. Nesse contexto, o presente artigo demonstra a maneira como o software 

comercial SAP2000 foi utilizado como ferramenta de ensino, para que fosse possível um 

melhor entendimento dos assuntos ministrados. Como resultado houve um aumento do 

rendimento dos alunos visto que o programa possui uma interface gráfica onde é possível 

observar os fenômenos físicos de maneira mais clara e possibilitar aos alunos 

conhecimento necessário para alavancar suas próprias experiências. 

 

Palavras-chave: Análise modal, dinâmica das estruturas, SAP2000, ferramenta de 

ensino. 
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1. INTRODUÇÃO 

Durante a disciplina de Dinâmica das Estruturas na Universidade Federal do Pará 

(UFPA) Campus de Tucuruí, foi perceptível o desconforto dos alunos no que se refere ao 

entendimento físico dos fenômenos que compreendem as análises modais. 

 O estudo de dinâmica em estruturas envolve complexos cálculos. No entanto, com a 

evolução da informática aliada aos diversos softwares de análise estrutural, fica cada vez 

mais prática e intuitiva a interpretação desses efeitos. De acordo com Tarouco (2003) e 

(ROMISZOWSKI, s.p.) o uso da tecnologia torna o processo de ensino-aprendizagem mais 

interativo, sendo assim, o rendimento do aprendiz é maior tendo em vista que há a 

construção de um ambiente que permite uma participação mais ativa do aluno. Nesse 

contexto, o objetivo deste trabalho é apresentar uma abordagem didática a respeito de 

análises modais e, desse modo, proporcionar maior confiabilidade na modelagem do 

sistema estrutural e autonomia na interpretação dos resultados, tornando mais simples o 

processo de aprendizagem. 

2. ANÁLISE MODAL 

Avitabile (2010) e Soeiro (2001) dizem que análise modal é utilizada para identificar as 

frequências naturais de um sistema mecânico. A quantidade de frequências naturais de 

um sistema depende de seus graus de liberdade, dessa maneira, uma estrutura pode 

apresentar diversas frequências naturais que são representadas pelos seus modos de 

vibração. 

2.1. MODOS DE VIBRAÇÃO 

Segundo Justo (2010), modo de vibração é a forma como a estrutura vibra, ou seja, é 

a representação de sua deformada mediante uma determinada frequência. Sendo assim, 

para cada modo existe uma frequência própria intrínseca à estrutura e, portanto, não tem 

relação com as ações atuantes. Além disso, os modos de vibração são determinados sem 

o efeito do amortecimento. 

2.2. FREQUÊNCIA NATURAL 

Conforme Hibbeler (2009), vibração é todo movimento repetitivo de um corpo ou 

sistema de corpos unidos, em torno de um ponto de equilíbrio. Ao deixar cair no chão 

dois objetos, um de metal e outro de madeira, será possível identificar que os sons 

oriundos dos impactos de cada um deles serão diferentes, mesmo que as alturas sejam 

iguais. Isso se dá, pois, os dois objetos vibram de formas distintas quando sofrem uma 

excitação, e, o som é a vibração no meio elástico com uma frequência que é capaz e ser 

percebida pelo ser humano. Essa particularidade de comportamento dinâmico de cada 

objeto se chama frequência natural, que nada mais é do que a vibração que o corpo adquire 

ao ser perturbado, tal propriedade depende de um conjunto de fatores tais como a 

elasticidade e a geometria do objeto. Portanto, a frequência natural (𝜔𝑛) é dada pela 

Equação 1, onde k é a rigidez e m a massa. 

 

 

𝜔𝑛 = √
𝑘

𝑚
 

(1) 
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3. METODOLOGIA 

As estruturas foram modeladas no software comercial SAP2000 baseado método dos 

elementos finitos (MEF). Através desse mecanismo foi possível analisar a estrutura para 

a indução de resultados que geraram a discussão sobre o assunto, e assim, possibilitou 

uma melhor interpretação física dos problemas. Desse modo, foi permitido analisar cada 

etapa da modelagem de uma estrutura padrão, e a partir dela atribui-se diferentes 

geometrias, condições de contorno e materiais, a fim de entender como essas 

modificações podem alterar as propriedades dinâmicas das estruturas como as frequências 

naturais e modos de vibração, além de atribuir ao aluno conhecimento para alavancar suas 

próprias experiências nesse campo da engenharia. 

4. MODELAGEM ESTRUTURAL 

O programa SAP2000 fornece uma pré-configuração do pórtico espacial a ser 

estudado, através da opção “3D Frames” pelo caminho “New model→ 3D Frames”. 

Algumas informações de geometria poderão ser inseridas na tela como representado 

conforme a Figura 1 e Figura 2. 

Figura 1 -  Dados de entrada 

 

  

Figura 2 - Pórtico lançado. 

 

  

Em seguida, acessando o menu “Define Materials” pelo caminho “Define → 

“Materials...”, seleciona-se o material “4000Psi” referente ao concreto e é escolhida a 

opção “Modify/Show Material...”, definindo-se as características do material que será 

componente dos elementos da estrutura como mostrado na Figura 3:  
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• Resistência à compressão do concreto (fc) = 25 MPa  

• Peso específico do concreto (γ) = 2500 kg/m³ 

• Poison (ν) = 0,2. 

• Módulo de elasticidade (E) = 28000 MPa 

Figura 3 - Modificações feitas nas características do material. 

 

Para a determinação das seções dos pilares e vigas acessamos o menu “Frame 

Properties”, através do caminho Define →Section Properties → Frame Sections. Em 

“Add New Property” cria-se uma nova propriedade para cada tipo de elemento, como 

mostrado nas Figuras 4 e Figura 5. 

 

Figura 4 -  Determinação da seção dos 

pilares. 

 

Figura 5 -  Determinação da seção das 

vigas. 
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Figura 6 - Escolha do material e espessura da laje. 

 

   

Por último, definem-se as características da laje. Admitiu-se laje de 0,25 m de 

espessura, maciça de concreto. Para tal configuração no software, segue-se o caminho 

“Define” → “Section Properties” → “Area Sections” de acordo com a Figura 6. 

 

 

 

 

 
 

Após terem sido feitas todas as configurações acerca dos materiais e seções dos 

elementos constituintes da estrutura, devem-se atribuir tais configurações aos elementos 

(pilares, vigas e lajes) e serem determinadas também as condições de contorno do pórtico. 

Para atribuição das configurações dos pilares, selecionam-se os quatro elementos 

representados na janela de trabalho do SAP2000 e segue-se o caminho “Assign” → 

“Frame” → “Frame Sections”, seleciona-se a opção “PILARES” previamente 

configurada e confirma em “OK”. 

Para atribuição das configurações das vigas o processo é semelhante; selecionam-se 

os quatro elementos representados na janela de trabalho do SAP2000 e segue-se o 

caminho “Assign” → “Frame” → “Frame Sections”, seleciona-se a opção “VIGAS” 

previamente configurada e confirma em “OK”. 

Para atribuir as configurações da laje, primeiramente deve ser feita determinação da 

área que a mesma irá ocupar na estrutura. Essa configuração é feita lançando-se no 

modelo um elemento de área, através do comando “Draw Poly Area”, que pode ser 

acessado na guia “Draw”. 

Após ativar o comando, selecionam-se os quatro pontos na estrutura do modelo que 

servirão de referência para locação da laje e confirma o lançamento pressionando a tecla 

enter. A área criada será representada por linha vermelha seguida de linha tracejada de 

mesma cor, como indicado na Figura 7: 
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Figura 7 - Representação de área da laje. 

 

Agora, depois de lançada área da laje, pode ser atribuída a configuração previamente 

feita para ela. Seleciona-se a área da laje no modelo, e segue-se o caminho “Assign” → 

“Area” → “Sections”.  Na janela aberta, seleciona-se a seção “LAJE” e confirma 

clicando em “OK”. 

Ainda na laje, para obter resultados mais precisos, é necessário que seja feita uma 

divisão da área da laje em subáreas com o intuito de um maior refinamento para o 

processo de cálculo do programa. 

Para tal configuração, segue-se o caminho “Edit” → “Edit Areas” → “Divide 

Areas”. Na janela que se segue, pode-se escolher o número de divisões feita na área nos 

eixos X e Y. Para a modelagem foi determinada malha de 8 x 8 como observado na Figura 

8. 

Figura 8 - Discretização da laje em malha de 8x8. 

 

Finalmente, determinam-se as condições de contorno do pórtico. Para o modelo 

padrão, definem-se todas as ligações engastadas.  

É feito primeiramente engaste dos pilares em relação à fundação selecionando os 

quatro pontos na modelagem encontrados na extremidade inferior de cada pilar. Segue-

se o caminho “Assign” → “Joint” → “Restraints”. Na janela que segue pode-se escolher 

entre vários tipos de vinculações. Para o modelo restringimos as movimentações nos três 

eixos que pode ser visualizado na Figura 9.  

 

Figura 9 - Vinculação dos pilares com as fundações. 
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Para os outros pontos da estrutura, atribui-se a opção “Merge Points”, que considera 

que os pontos em um raio pré-configurado de influência estão unidos. Para atribuição 

desta configuração, selecionam-se os pontos externos da malha da laje e segue-se o 

caminho “Edit” → “Edit Points” → “Merge Points”.  

 Na janela que segue insere-se o valor do raio de influência do comando. Para a 

modelagem foi atribuído valor de 0,1, podendo este valor ser até mesmo zero, levando-se 

em conta que queremos unir apenas o ponto que liga os elementos laje, viga e pilar segue 

um exemplo na Figura 10. 

Figura 10 - Atribuição do comando “Merge Points”. 

 

Finalmente o modelo apresenta-se como indicado na Figura 11 abaixo: 

Figura 11 - Aspecto final do pórtico. 

 
 

Após todas as configurações realizadas a análise é feita por meio do padrão de análise 

“MODAL”, que nos fornecerá as propriedades dinâmicas da estrutura como a frequência 

natural e os modos de vibração.  Segue-se o caminho “Analyze” → “Run Analisys”. Na 
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janela que se segue, deve-se selecionar o modo “DEAD” e desativá-lo, rodando apenas o 

modo “MODAL”, confirmar e iniciar análise clicando em “Run Now” de acordo com a 

Figura 12. 

 
Figura 12 - Escolha do modo de análise. 

 
 

5. RESULTADOS E DISCUSSÕES 

Os resultados de deformação representados nas Figuras 13, 14, 15 e 16 a seguir, são 

obtidos através do caminho “show deformed shape” e selecionando a opção “modal”. 

 
Figura 13 - Modelo padrão de concreto 

 

Figura 14 - Modelo de aço 

 
 

Para a Figura 13 os resultados obtidos para a frequência natural de cada modo de 

vibração desse modelo serão utilizados como parâmetro de comparação para os outros 

modelos. Essa versão do SAP2000 informa o período, e a frequência pode ser obtida 

através da expressão onde a frequência é o inverso do período. Sendo assim a frequência 

encontrada foi igual a 7,14 Hz. 

 Para a Figura 14, que corresponde ao modelo feito de aço (onde utilizou-se E= 

200000 MPa, γ = 7850kg/m³ e ν = 0,3), a frequência obtida foi 10,74 Hz, esse resultado 

era esperado, visto que o módulo de elasticidade do aço utilizado na modelagem é 7,14 

vezes maior que o do concreto, e este estando diretamente ligado à rigidez (k) trouxe um 

aumento nas frequências naturais da estrutura. 
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Figura 15 - Modelo com Seção de pilar 

40x20 

 

Figura 16 -  Modelo com apoio de segundo 

gênero 

 
 

A Figura 15 mostra que a mudança na geometria da seção do pilar de 40x40 

centímetros para 40x20 centímetros teve uma grande redução da frequência natural no 

sentido da menor inercia do mesmo, sendo a nova frequência de 3,33 Hz. Esse resultado 

era esperado visto que a diminuição da seção transversal do pilar iria afetar a rigidez (k) 

da estrutura. Desse modo, o eixo que ficou com a menor inercia foi o mais afetado. 

A Figura 16 mostra que a utilização de apoios de segundo gênero fez com que o 

resultado da frequência natural tivesse uma grande redução quando comparado ao modelo 

padrão. A nova frequência de 3,4 Hz se dá pelo fato de que as condições de contorno têm 

uma grande influência sobre as propriedades dinâmicas da estrutura, e a troca de um apoio 

de terceiro gênero por um apoio de segundo gênero tornou isso evidente. 

6. CONSIDERAÇÕES FINAIS 

A aplicação dessa metodologia durante a cadeira de Dinâmica das Estruturas na 

Universidade Federal do Pará - Campus Universitário de Tucuruí utilizando o SAP2000 

versão 14.0.0 presente nos laboratórios da instituição, mostrou um aumento significativo 

na compreensão dos alunos. Todas as análises e resultados possíveis podem ser 

visualizados através da interface gráfica do programa o que possibilita uma maior 

percepção física dos fenômenos, e assim, um maior rendimento durante as aulas visto que 

o uso dessa ferramenta ajuda a reter a atenção dos discentes. O avanço da tecnologia 

permite uma facilidade no ensino, porém, essas ferramentas ainda são pouco exploradas, 

sendo assim, é necessário que metodologias como essa sejam cada vez mais utilizadas 

para assim possa haver uma maior aprendizagem dos alunos. 
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SAP2000 USAGE AS A TOOL FOR MODELING AND TEACHING 

MODAL ANALYSIS AND ITS CONDITIONING FACTORS 
 

 

Abstract: The dynamic of structures is an engineering branch which studies the 

behavior of structures under dynamic effects. The subjects that comprise this field have 

been increasingly included in civil engineering courses. Therefore, during During the 

development of the Dynamic of Structures subject in the Universidade Federal do Pará – 

Campus Tucuruí, It was perceptible the difficulty from students with the physical 

understanding of the phenomena that comprise the modal analyzes. In this context, this 

paper demonstrates how the comercial software SAP2000 was used as an education tool, 

to enable a better understanding of the subjects taught. As a result, student yield have 

been icreasing due to the program's graphical interface, which makes it possible to 

observe the physical phenomena more clearly and to give students the knowledge 

required to leverage their own experiences 

 

Key words: Modal analysis, dynamic of structures, SAP2000, education tool.  

 

 


